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Highline College 

Busn 216: Computer Applications for Business 

Video #01: Introduction to Microsoft 365 and Windows Explorer 

1. Microsoft Office Applications/ Programs/ Apps (Application Software) 

▪ Windows Explorer 

i. Manage Files and Folders (Create and Name Folders, Save Files, Delete Files and Folders, 

Copy Files and Folders, Move Files and Folders) 

▪ Word 

i. Create Documents with Word, Formatting and Inserting Pictures like Flyers, Business Letters 

and Creating Word Templates, Research Papers, Save and Save as. 

▪ PowerPoint 

i. Creating Presentation with words, images, design. (Movement and sound to articulate a 

message)  

▪ Excel 

i. Store Data, make calculations, perform data analysis (data into information), make charts 

and PivotTables. 

▪ Access 

i. Store data in related tables and create information and reports from the raw data using 

queries. 

▪ Outlook 

i. Create and send messages, merge letters/email messages using data from Excel or Access, 

create appointments and meetings, and create folders to organize email messages. 

2. Operating Systems 

▪ Operating system is a computer program that coordinates activity between memory devices, 

printers, and programs (Microsoft applications software) like Word and Excel. 

▪ Windows 10 is an operating system that I will be using for the videos in this class. 

▪ You might have a different operating system, such as Windows 8 or 7.  

▪ Our study in this class of Word, PowerPoint, Excel and Access will not be affected by the operating 

system. 

3. Task Bar 

▪ Contains icons to open the different Programs/Applications like Word, Excel, PowerPoint, Access 

and Outlook. 

 

Figure 1 - Task Bar 
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▪ To add an icon to the Task Bar, right click the program name in the Start Button or in the “Tile 

Screen” and point to “Add icon to Task Bar”. 

To add an icon to the Task Bar or Pin to Start 

Pin to Start:  

i. Click on the start Button to open the tile screen; 

ii. If you do not see the program you want to pin, type to search the program on the search bar 

iii. Right-click on the program that you would like to Pin to Start or to add to the Task Bar.  

iv. Left-click on “Pin to Start”. This adds an icon to the “Pin to Start” on your Tile Screen. 

To add to the Task Bar:  

 Follow the steps above i – iii, skip step iv and move to step v. 

v. Right-click on the “More” arrow button 

vi. Click to select “Pin to taskbar”. This adds an icon to the Task Bar. 

 

Figure 2 - How to Pin Icon on Tile and Task Bar 
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Figure 3 - Icon on Tile and Task Bar 
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4. Start Button 

▪ Windows 7 or 10 

i. Start Button 

ii. To open Start Button on Windows 7 or 10 use the keyboard Window Key  

5. Put the USB Flash Drive into a USB Port 

▪ USB Flash Drive is a “File Storage Medium” 

▪ The USB Port is located on the back or front of the computer and for the laptop it is located on the 

side. 

6. Windows Explorer (Folders Window) 

▪ Windows Explorer is used to manage files and folders 

▪ Open the Windows Explorer (File Explorer) by clicking on the Files Explorer icon on your Task Bar or 

using the keyboard shortcut. 

i. Keyboard shortcut is  + E 

o Hold Window Key , and then tap the letter E key. 

ii. Keyboard Shortcut key to show Desktop:  + D 

o This keyboard will get you back to the desk to and away from the start screen with 

the “Apps Tiles”. 

7. What does Windows Explorer do? 

▪ Left side of the Windows Explorer (also called the Folders Pane) 

i. This shows you the hierarchical structure of the entire computer 

ii. Use this to navigate to or to select the drive, flash drive or folder that you would like to 

view/open. 

iii. Your folders and drives will also have the “triangle button”  (sometimes they will appear 

as + and – ) symbols to open and close the folders and drives. 

o If you click the expand  button, this will expand your folder and the folders inside 

this folder will appear on the left side of Windows Explorer, below your folder (the 

one that you have expanded) and will be slightly indented. 

o If you click the collapse  button, this will collapse all contents in your folder and 

they will not be viewable. 

▪ Right side of Windows Explorer 

i. This shows the content of the item that is selected on the left side 

o You can see the folders 

o You can see the files 

ii. The white area can be used to create new folders 

iii. You highlight the folders or files to delete, cut, or move the files or folders 

iv. You double click the file on the right to open the file 

v. You right click to rename the file or folder, you can also use the keyboard shortcut F2 to 

rename 

vi. You can sort the column of files or folders by clicking on the column header. 
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Figure 4 - File Explorer 

 

▪ View Tab in the Ribbon 

i. You can use the View tab on the Ribbon, and from the layout group you select how you will 

view your files or folders. 

ii. You can also use the pane group to select if you want a preview or detail pane for your files 

o You use the preview pane to preview what is in your file before you open the file 
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▪ Search box in the upper right corner of Windows Explorer Window 

i. Select folder, type text, hit enter. 

ii. Use asterisks * when searching for partial text. 

o If you are searching for any file that contains a particular word, for example, you are 

searching for a file that contains the word “report”, type *report*  

o Asterisks means find zero or more characters. 

 

Figure 5 - File Explorer-View Tab  

 

8. Folders and Keyboard for creating Folders 

▪ A Folder = It is a named location on a storage medium that contains related documents or files. 

▪ Create New Folder in Windows Explorer with the Keyboard shortcut: Ctrl + Shift + N 

i. You can also Right Click on your white space in Windows Explorer, Click New Arrow, then 

Click Folder. 

ii. In Windows Explorer, on the Home Tab in the Ribbon, on the New group, click New Folder 

to create a new Folder. 

iii. Use the Function Key F2 to put your selected folder in Edit mode, this will enable you to 

rename your folder. 
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Figure 6 - Creating and Renaming Folders 
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9. Deleting a File or Folder and the Delete Key 

▪ If you delete a folder or file from a Jump Drive (USB), the item is permanently deleted. 

▪ If you delete a folder or file from your computer (for example from your desktop or C Drive), the 

item is sent to the Recycling Bin. 

10. Naming Files, Folders, Worksheets in Excel, Tables and PivotTables in Excel, Tables in Access or Queries in 

Access is one of the most important computer skills. 

▪ Always name things with names that indicate what data or information is contained in the file, 

folder, Excel Worksheet, Excel Tables/PivotTables/Queries, or Access Tables/Queries. 

▪ If you want to sort Files or Folders differently than in alphabetical order, then you must add 

numbers at the beginning of each name. 

i. For example, if you would like the file/folder named “Zebra” to appear before a file/folder 

named “Apple”, when the column is sorted “A to Z”, you could rename the file/folders to 

begin with a number: “01-Zebra” and “02-Apple”. 

11. Title Bar 

▪ Horizontal strip that contains the program’s name and the file name. 

▪ Upper Right: 

i. Close (x) 

ii. Maximize or Restore Down 

iii. Minimize (-) this does not close the file – just sends it to the Task Bar. 

iv. Ribbon Display Options – To hide the Ribbon or choose how you want to display the Ribbon. 

 

Figure 7 - Title Bar 

 

Figure 8 - Ribbon Display Options 
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12. File menu in Excel, Word and other Microsoft Programs = Backstage view in Excel, Word, PowerPoint, or 

Access. 

▪ File Menu: Backstage View 

 

Figure 9 - File Tab: Backstage View 

 

Figure 10 - File Tab: Backstage View 

▪ Esc Key: Closes the Backstage View (See picture on the next page). 

a. New: Templates or Blank. Keyboard shortcut to open a new file: Ctrl + N  

b. Open: Ctrl + O 

i. You can use this to access Recent Files 

ii. Bottom of Recent Files List is “Recover Unsaved Documents” 

c. Info: Information about the file 

d. Save: Use to save your work as you work on your file. Keyboard Shortcut: Ctrl + S 

i. For a new File if you click ‘Save’ or Ctrl + S it will open for you the ‘Save As’ dialogue box 

for you to select a location to save your file. 

e. Save As: Use this to save the file if the file was not saved before or if you want to make a 

duplicate of the file. It is similar to Save but it allows you to change the location and/or file 

name, or the file extension. Keyboard shortcut: F12 

f. Save As Adobe PDF: PDF stands for Portable Document Format. Use this when you want to save 

files that you can easily share and print but you do not want them to be modified. 

g. Print: Select this to Print. Keyboard Shortcut: Ctrl + P 
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h. Share: use this to share your documents online 

i. Export: Use to save a copy of your open document/file in a different format or type that is 

required by a different application. 

j. Transform: Tool designed to enhance conversion.  

k. Close: This closes your File 

l. Account: Information about your account, includes the office version that you are using. 

m. Options: Set Defaults. 

 

Figure 11 - File Tab: Backstage View 
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13. Ribbon  

▪ Tabs: It is important to note that each Tab has one or more groups 

i. Groups 

o Buttons – Click on the command buttons to do something for example: Underline, 

Change font, Bold, Create Bullet List, etc. Some Buttons have arrows that you can 

click on to select more options. 

o Boxes 

o Text boxes 

o Check boxes 

o Galleries (grid of choice) “More” button 

o Enhanced ScreenTips (shows keyboard shortcuts) 

o Dialogue Launcher: You can click on this icon to open up a task pane that will 

provide you with more options related to that group. 

o Task Pane 

ii. Contextual Tabs: These are ribbon tables that will show up when an object is selected, like a 

picture in word, table in excel). 

iii. Hide Ribbon: Keyboard shortcut: Ctrl + F1 

iv. KEY: Note that if you change the size of your Window, the buttons and groups in the Ribbon 

Tab will also change in size.  

▪ NOTE: you can also customize your Ribbon to add more Tabs or remove Tabs. Tabs, and Groups will 

also vary between Microsoft Programs. 

 

 

Microsoft Word Ribbon 

 

Figure 12 - Ribbon: Microsoft Word 
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Microsoft Excel Ribbon:  

o The Tabs and Groups are different from the ones in the Microsoft Word Ribbon. 

 

Figure 13 – Ribbon: Microsoft Excel  

▪ Customize the Ribbon: 

Below are two different ways of how you can open the task pane for you to customize your ribbon. Both will 

open the Task Pane that will provide you with more options of customizing your Ribbon. 

o Customize the Ribbon from Quick Access Tool Bar (QAT) 

 

Figure 14 - Customize Ribbon using QAT 

 

o Customize the Ribbon from the Dialogue Box Launcher 

 

Figure 15 - Customize Ribbon 
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▪ Once you open the Task Pane, then you are ready to customize your Ribbon. See the figure below of a 

task pane open in Word option on how to customize your Ribbon. 

 

 

Figure 16 - Customize Ribbon 
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14. Status Bar 

▪ Located at the bottom of your file and above the Task bar 

▪ Does different things in every program and you can customize it by right clicking on it. For example 

in Word you can show page number, word count, etc. 

 
   Figure 17 – Status Bar 

 

15. Quick Access Toolbar (QAT) 

▪ Easy to add buttons from Ribbon 

▪ Add any button from “Customize QAT” in options, but be sure to select “All Commands” from the 

“Choose Commands from” drop-down. 

 

Figure 18 - Quick Access Toolbar (QAT)



Page 15 of 21 
 

16. Save:  

▪ Saves the changes you made in the file. You can choose from your QAT to have AutoSave on or off 

▪ Does different things in each program. 

▪ Use to save your work as you work on your file. Keyboard Shortcut: Ctrl + S 

o For a new File if you click ‘Save’ or Ctrl + S it will open for you the ‘Save this file’ dialogue 

box for you to name your file and select a location to save your file. 

i. Type in the ‘File Name’ box to name your file. 

ii. Click to drop-down arrow to choose a location. 

iii. Click ‘Save’ to save your file and close the dialogue box. 

 

Figure 19 – Save _ dialogue box 
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17. Save As 

▪ Allows you to save a file, change the location, name, or file extension. 

o File Location – where do you want to save the file. 

o File Name – what do you want to name/call your file. 

o File Extension – what is the type of the file. 

▪ When you Save As, you create a new file. 

▪ Keyboard shortcut: F12 

How to Save As: 

Click on the File Tab to open up the Backstage view, or use the keyboard shortcut: F12, then follow 

the steps listed below and as shown in the figure --- 

Note: the keyboard shortcut will open for you the File Explorer for you to choose the location where 

you want to save your file, to name your file and/or change the file extension. 

i. Select ‘Save AS’ 

ii. Choose the location where you want to save your file. You can use the ‘Browse’ Button to 

choose the location of your choice. 

iii. A ‘Save As’ dialogue box will open. From here you can choose a particular location to save 

your file, name your file and/or change the file extension. 

iv. Select ‘Save’ to save your file and close the Save As dialogue box. 

 

Figure 20 – Save As  
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Figure 21 – Save As _ dialogue box 
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18. File and File Extensions 

▪ Named unit of storage 

▪ Files can be created by Word, Excel, PowerPoint, Access, Phone Camera, Pictures, etc. 

▪ It is very important to have the file extension showing as this will help you understand what the file 

can and cannot do. 

▪ File extensions examples: “.docx”, “.docm”, “.dotx”, “.xlsx”, “.xlsm”, “.pdf”, “.jpg”, “.accdb”, “.pptx”. 

File extensions provide useful information about what sort of file it is, what program created it and 

whether or not you are allowed to write VBA code in the program file. 

i. A word file that has an extension: 

o “.docx” indicates that it is file that was created in Word 2007 or later 

o “.docm” indicates that the file was created in Word 2007 or later AND the “m” 

rather than “x” means that the file has Macros1, or you can have Macros in the file. 

o “.dotx” indicates that the file is a template that was created in Word 2007 or later.  

a. Template – means it has default layout and settings that are used to create 

a new document. 

ii. An Excel file that has an extension: 

o “.xlsx” indicates that the file was created in Excel 2007 or later. 

o “.xlsm” indicates that the file was created in Excel 2007 or later AND the “m” means 

you can have Macros in the file, or the file has Macros2.  

o .xls – This as an Excel file that was created 2003 or earlier. 

o .xlst – This is an Excel Template format extension 

o .csv – This is a data file that you can open but not really an Excel file. 

iii. A PowerPoint that has an extension: 

o “.pptx” indicates that it is file created in PowerPoint 2007 or later. 

iv. An Access file that has an extension: 

o “.accdb” indicates that it is a file created with Access 2007 or later. 

How to save a word3 document with a different extension:

 

Figure 22 - Change File Extension 

 
1 Macros means that there is code written behind the scenes. It can either be in word or Excel. 
2 We will use this extension “.xlsm” on Excel files in this class but we will not write the code. 
3 File Extension list may be different for each program. 
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19. Show File Extensions 

▪ “.docx”, “.docm”, “.dotx”, “.xlsx”, “.xlsm”, “.pdf”, “.jpg”, “.accdb”, “.pptx” these are called file 

extensions. 

i. The x at the end means XML (Extensible Markup Language) computer code does not contain 

macros. 

ii. The m at the end means Macros meaning the file is macro enabled or has Macros. 

▪ Many computers come with the default settings not to show the file extensions. 

▪ To show file Extensions:  

We have two ways that we can show the file extensions. In Windows Explorer and from the Control 

Panel. You can choose either of these as both will show the same results. 

 

i. In Windows Explorer: 

o Click on your Windows/File Explorer or use the keyboard shortcut  + E to open it. 

 

      Figure 23 - Show File Extensions 

 

o Once the File Explorer opens, click on the “View” Tab on the Ribbon and on the 

“Show/hide” group, select the check box “File name Extensions”, a check mark will 

appear. 

 

 

 

       Figure 24 - Show File Extensions   
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ii. In Microsoft 365: 

o Click on Start Button, Search for ‘Control Panel’ and select/left-click on it to 
open. 

 

Figure 25 - Control Panel: Show File Extensions 
 

o From the Control Panel select/left click on “Appearance and Personalization” to 
open “File Explorer Options”. Click on View Tab to change the settings. 

 

Figure 26 - Control Panel: Show File Extensions 

 

 

Figure 27 - Control Panel: Show File Extensions 
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20. Useful Keyboard Shortcuts 
▪ Open Start in Task Bar: Window Key  

▪ Open “Tiles Screen” in Windows 8: Window Key  

▪ Open Windows Explorer:   + E 

▪ Show Desktop:   + D 

▪ Show other Open Windows/Programs:  + Tab 

o With all open Windows showing, you can use the mouse or the Arrow Keys to move 

between open Windows/programs and select the one you want. 

▪ Esc: Close most open dialog/options boxes or will help you to “escape” when you accidentally put a 

file or folder in edit mode. You can also use “escape” to exit out of Backstage view. In Excel if you 

have the formula in edit mode, Esc will help you exit the edit mode. 

▪ Create New Folder: Ctrl + Shift + N 

▪ Rename Folder/File: F2 

▪ Home: “Jumps to front of line” 

o In a file or folder that is being renamed, it will jump to front of the name. 

o In Word it will jump to front of the line. 

o In Excel it will jump to front of the formula 

▪ End: “Jumps to the end of line” 

o In a file or folder that is being renamed, it will jump to end of the name. 

o In Word it will jump to end of the line. 

o In Excel it will jump to end of the formula 

▪ Move up and down through a list of folders or files: Arrow Keys   ←↑↓→ 

▪ Save As: F12 

▪ Save: Ctrl + S 

▪ Close File or Program: Alt + F4 

▪ Open: Ctrl + O 

▪ New File: Ctrl + N 

▪ Print: Ctrl + P 

▪ Hide and open Ribbon: Ctrl + F1 

▪ Zoom Screen: Ctrl + Wheel on Mouse 

▪ Maximize Window:  + ↑ 

▪ Minimize Window:  + ↓ 

▪ If a button is highlighted in a Dialog Box, to invoke that button you can use the key “Enter”. 


